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Vector 6  
Professional User Guide
Vector 6 Labelling is a professional software package for the production of labels. The software 
is a very powerful application with many features to accommodate the many different tasks 
that each business may require. This guide is designed to accompany training and covers the 
basics of label design.
 

Basic Navigation
The main screen has standard Microsoft Office Style features.

This is how the toolbar looks when you have a label open on screen and it provides access to 
the main tools for designing labels.
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Opening a label format
To open a label format click File > Open > Format or click on the Folder icon in the quick access 
toolbar. 

The default directory for the formats is the FMT directory. The Microsoft Windows file 
architecture allows files to be organised in whatever way you like.

When a format is highlighted in the browse dialogue box you will see a preview of design to 
help ensure you have selected the correct format. When the required format is selected click 
on Open to open the format into the main window for printing or editing.
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New Format
To start a new format either click the new button from the quick access toolbar or click File > 
New > Format. For the purposes of basic training please ignore the Job, Label Set and Label 
options.

You will then be presented with a screen offering Printer, Speed and Temperature options.
 

Temperature and speed settings options are dependent on the printer driver settings of the 
currently selected design printer. In most installations involving the Toshiba B-SX5 printers 
the temperatures should not need to be set over +2. If higher settings are required to achieve 
good print quality please contact a member of the support team at Progressive ID Limited; 
prolonged use of excessive temperatures can will result in printer damage.
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Format dimensions can be applied by clicking on the Edit Label button on the screen. Here 
you can set the label dimensions including width, height, horizontal gap, and number of labels 
across. This is also where the sensor type is chosen.

Sensor settings
Different label stocks require different sensor settings. Here is a basic guide to choosing the 
correct sensor settings.

SENSOR L ABEL T YPE

Transmissive Plain self-adhesive label

Reflective Plain card with a black line registration mark

Transmissive (PrePrinted) Preprinted self-adhesive label especially with colour and graphics

Reflective 3 (Label) Clear self-adhesive label with a black line registration mark

These are the primary options that will be in the day to day use. The other options shown 
should be used under guidance from Progressive ID Limited. If no ribbon is being used (direct 
thermal materials only, please check for sustainability) place a tick in the Thermal Paper box.
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When a background image is required you must browse for the image required in the Picture 
Name section shown above. To embed the image permanently onto the design you must tick 
Embed Image. This picture is for display purposes only and will not print.

New Format Elements
A new format will be displayed in its own Window with Home tab visible across the top.
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Text Blocks
The most frequently used data field type is the Text Block. In almost all cases the Normal Text 
tool is used to add a text box to a label. It is sometimes necessary to use the Printer Text Block 
option when sequential numbers are used, but in general use the True Type Fonts provide the 
most flexible and visually versatile choices.

To create a Text Block on the label single click on the TTF Block button and position the cursor 
on the label. 

Hold down the left mouse button and drag field open to approximately the size required.
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As soon as you let go of the mouse button the cursor will appear within the text box allowing 
text entry in text box edit mode.

Whilst in the text box edit mode the main toolbar along the top of the screen changes to 
provide text formatting features including Font selection, size, width control, underline, italic 
and reversal as well as justification. The same controls appear on both the Home tab and the 
Text tab.

You must highlight text characters before any changes will take effect. To highlight the 
characters place the mouse arrow to the right of the text and drag the mouse across the text. 
Once highlighted the toolbar can be used to make changes.
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To avoid data loss due to text boxes overlapping it is advisable to keep text boxes as small as 
possible.

If you make the text box too small you will be presented with this error message. 

This message indicates that the field contains information that is too large for the size of the 
of the box provided. To correct the problem you need to enlarge the field size. Always ensure 
that text box is big enough but not too big.
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Variable information in a text field should be tested with the longest data combinations which 
may be used by the design; this will be covered in detail later. The optimum size for a text box 
is to have the box just a bit deeper than the cursor or highlighted area when text is highlighted. 
The width of the box is dictated by the length of the data in the box. With fixed information 
the box can be tight against the last character in the field. With variable information please 
refer to variable text later in this document.

This picture shows how a text box that is too small will present itself to an operator.

The red error warning in the corner will show when the Block Borders button on the View tab 
is active, indicating that the block if too small for the content.

If you manage to design a label with a text field that is too small and all warnings are ignored 
when you try to print the label you will be presented with the following error message. 

This message will show if the box is too small for the fixed information contained within it or if 
variable information that gets supplied at print time is too large for the area supplied.

Each field on a label format will have an identification number. This example tells you that 
Block No. 1 has a fault. When there are multiple fields on a design you can easily identify the 
field number of the currently highlighted field by looking in the bottom right hand corner of 
the screen.

Use the TAB key to cycle through the different fields on a label to locate the block that is 
causing problems.

testing with data

For example with an origin 

variable, test with Dominican 

Republic rather than Cuba, or 

Northamptonshire rather than 

Kent.
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In some instances it is necessary to restrict the text block to a fixed size that is smaller than the 
largest data combination. In these cases you can enable Fit Font to Block by clicking on the text 
block Properties button whilst in the Edit Text block mode.

When enabled this allows the user to specify a maximum size that the font is able to be 
printed. If the data that is being printed reaches the block size limits the font will automatically 
be reduced in size to the largest size that will fit in the block. You can also set a Minimum size 
that you do not want the font to get smaller than.

The use of width control can be used in conjunction with Fit Font to Block to maximise space 
without reducing the height of the text characters. Typical settings to use are Minwidth = 75 
(%) and Maxwidth = 100 (%).

These pictures show the same text box being populated with two variables of different 
lengths. You can see that the box has remained the same size whilst the text on EVERGLADE 
has automatically shrunk.
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To avoid text boxes from overlapping and potentially blocking out data from being printed, you 
can also click the properties button to adjust the Text Properties boundaries.
 

The text blocks in this picture have been optimised with the heights reduced to their limits. 
Both contain text set at 11pt Arial. The blocks on the left have got the default settings applied 
in the properties section of the text block. The blocks on the right have had the all of the 
boundary options deactivated except Descent to the space above and below the text.
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Variable Data
Variable data can take a number of different forms. The most frequently used include the 
following:

Prompted
Keyboard entry data which is asked for at print time. Typical uses of this variable type are 
where data changes every time the label is sent to print. This data is not stored in a database 
and no spell checks are made against what is entered. Guidance as to what data should be 
entered can be offered in the prompt that gets shown to the operator at print time and Input 
Masks can be used to restrict character entry. 
 
In some cases prompted variables are used to create specialised links between Vector and 
Front End Modules such as the DDO Depot Date Offset automation software. This will be 
explained in more detail in a separate appendix.

Database
This variable type provides a permanent link between the label format and a database/s of 
relevant information that is required at print time. A database linked label format can be 
used to provide a standardised template that is used to generate labels for a large number of 
products. It avoids the need to keep redesigning a label every time the data changes, as long 
as the database is kept up to date the label format will be automatically kept up to date.

Variable data can be used in text fields, barcodes, picture lookup blocks, and can be used 
directly as printable items as well as phantom block providing print time feed back and 
instruction.

Other variable types include:

Sequential numbers
This variable will provide a counter which can be configured to calculate changing numbers on 
a batch of labels.

Macro
This option can be used to perform scripted actions. It can also be used to add fields together, 
calculate check digits, strip unwanted characters from other variables.
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Prompted Variables
The example shown here will cover a prompted variable within a text box. This variable type 
can be used in a barcode or picture block but most applications use the text box feature.

1.	 Place an empty text box onto the label and whilst in the edit mode click on the variable 
button to enter the variable editor.

2.	 Highlight ‘Prompted’ from the list of variable types and click New.
3.	 Give the variable an appropriate Name and a Prompt. The prompt is usually a pertinent 

question or instruction that is given to the operator at print time. E.g ‘enter batch 
number’ or ‘enter grower code’. It can sometimes be useful to provide an example of the 
required format within the prompt.

4.	 The length can be set a maximum number of characters or can be made variable length. 
This variable option allows flexibility if the maximum number of characters that will be 
entered is unknown.

5.	 Recall last entry, when checked, will show the operator what data was used on the 
previous print run. Useful if the same data is regularly used, dangerous if the data must 
change every time the label is printed.
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Database Variables
This short example shows how to link a text box database variable to a database table.

1.	 Place text box on label and when in edit mode click the variable button on the toolbar. 
Select database from the list of options and click new.

2.	 Give the variable a suitable title and enter a relevant prompt in the prompt box.
3.	 Ensure that the correct database is selected and choose the required table from the list of 

tables available. You can now define the search criteria for variables associated with this 
table and you can specify the data that will be used in this variable.

4.	 Select whether you require the variable to be variable length or not and choose Recall 
Last Entry option.

5.	 Click apply and then inset the variable into text field.
6.	 Once a variable, either prompted or database has been inserted into the text box you can 

use the font formatting tools to make the information appear the way you want.
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Glossary of terms
Many people and many software packages have different names for the things that will be 
referred to in this document. This section is intended to help the reader correctly understand 
the terms being used in reference to the Vector Labelling software package.

Label
A label is a stock size. Its entire purpose is to provide the user with an area in which to arrange 
the data they wish to print. A label consists of information regarding size, orientation, number 
of labels across the web, sensor type and in some cases the shape of the stock being printed 
on.

Format
This phrase is used to refer to the design and layout for the information being used. Typically 
this information is a mixture of fixed and variable information. A label format is the most 
important component in use with the Vector software. It is a combination of the Label (stock 
size) and the information (both fixed and variable).

Database
This is where data that is to be used by the format is stored. Lists of information can be 
efficiently stored here and gathered on demand for printing. The effective use of a database 
will provide the opportunity to create a small number of formats that can be used to print a 
set of standard designs using predefined information.

Fixed Information
This is information that is placed onto a Format that stays the same every time the Format 
is printed. It is usually presented in the form of text. Typical examples include titles to areas 
containing variable data. e.g. DISPLAY UNTIL, COUNTRY OF ORIGIN, BATCH NUMBER. Fixed 
information can also be lines or pictures.

Variable Information
This is information that is entered manually, drawn from a database or calculated at print 
the time of print. Variables take the form of text entries, barcodes and pictures. The variable 
section of the software provides the operator with an easy to use variable generator that is 
explained in detail later. The two most commonly used variable types are - Prompted variables 
and Database variables. 

Prompted variable - Data that is typed upon demand when format is printed. Not linked to a 
database this option is entirely dependent upon user input. 

Database variable -  Data that is drawn form a database on demand at print time. When 
multiple database variables are linked to a table you can populate a number of format fields by 
answering one question.

Please use this document as a guide to the Vector software and refer to the Help guide found 
in the toolbar for any further clarification.


